# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Installation Guide</td>
<td>2</td>
</tr>
<tr>
<td>Communication and Handling</td>
<td>3</td>
</tr>
<tr>
<td>System Features</td>
<td>4</td>
</tr>
<tr>
<td>Notes on Online Help and Documentation</td>
<td>5</td>
</tr>
</tbody>
</table>

**Product Information**

12.2001 Edition
Classification of Safety–Related Notices
This manual contains notices which you should observe to ensure your own personal safety, as well as to protect the product and connected equipment. These notices are highlighted in the manual by a warning triangle and are marked as follows according to the level of danger:

Danger
Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury or in heavy damage to property.

Warning
Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

Caution
Used with the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury.

Caution
Used without the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in property damage.

Notice
Indicates a potential situation which, if not avoided, may result in an undesirable result or state.

Trademarks
SIMATIC®, SIMATIC HMI®, SIMOTION® and SIMATIC NET® are registered trademarks of SIEMENS AG.
Third parties using for their own purposes any other names in this document which refer to trademarks might infringe upon the rights of the trademark owners.
Safety Instructions Regarding your Product:
Before you use the product described here, read the safety instructions below thoroughly.

Qualified Personnel
Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are defined as persons who are authorized to commission, to ground, and to tag circuits, equipment, and systems in accordance with established safety practices and standards.

Correct Usage of Hardware Products
Note the following:

⚠️ Warning
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed correctly, and operated and maintained as recommended.

Before you use the supplied sample programs or programs you have written yourself, make certain that no injury to persons nor damage to equipment can result in your plant or process.

EU Directive: Do not start up until you have established that the machine on which you intend to run this component complies with the directive 89/392/EEC.

Correct Usage of Software Products
Note the following:

⚠️ Warning
This software may only be used for the applications described in the catalog or the technical description, and only in connection with software products, devices, or components from other manufacturers which have been approved or recommended by Siemens.

Before you use the supplied sample programs or programs you have written yourself, make certain that no injury to persons nor damage to equipment can result in your plant or process.

Copyright © Siemens AG 2000–2001 All rights reserved
The reproduction, transmission or use of this document or its contents is not permitted without express written authority. Offenders will be liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved.

Disclaimer of Liability
We have checked the contents of this manual for agreement with the hardware and software described. Since deviations cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual are reviewed regularly and any necessary corrections included in subsequent editions. Suggestions for improvement are welcomed.

Technical data subject to change.
# Table of Contents

1 Introduction ................................................................................................................. 1-7
   1.1 Basic representation of design time ................................................................. 1-8
   1.2 Basic representation of runtime ................................................................. 1-9
2 Installation Guide ........................................................................................................... 2-11
   2.1 Hardware and Software requirements for design time ................................. 2-11
   2.2 Hardware and Software requirements for runtime ........................................ 2-12
3 Communication and Handling ..................................................................................... 3-13
   3.1 Basic procedure ............................................................................................... 3-13
   3.2 Exporting OPC data at the design time ........................................................ 3-14
      3.2.1 Parameterizing the data export ............................................................. 3-14
      3.2.2 Exporting OPC data (symbol file) ....................................................... 3-15
      3.2.3 Exporting “OPC Alarm/Event” ............................................................. 3-16
   3.3 Configuring the OPC server/SIMOTION device interface at runtime ............. 3-16
4 System Features ............................................................................................................ 4-19
   4.1 System variables .............................................................................................. 4-19
   4.2 Consistent data access ..................................................................................... 4-20
   4.3 Compatibility with version 2.2 ........................................................................ 4-21
5 Notes on Online Help and Documentation ................................................................. 5-23
A SIMATIC NET – Support and Training ............................ A-25
   Automation and Drives, Service & Support ....................................................... A-25
Introduction

What is SIMOTION?
SIMOTION is an extensive system for the automation of production machines focusing on motion control.
SIMOTION comprises:
• SIMOTION SCOUT,
  an engineering system for creating a project by:
  – Configuring, programming, parameterizing
  – Graphical or text–based programming
  – Transfer to the kernel of e.g. SIMOTION C230–2
The project includes the hardware configuration and user data.
• SIMOTION Kernel
A kernel for various hardware platforms.

What is SIMATIC NET?
SIMATIC NET provides a default OPC server which enables access to the most different communication partners via the open OPC interface.

For a detailed description of SIMATIC NET please see the CD–ROM "SIMATIC NET PC/Windows 07/2001".

Which functionality is provided by SIMATIC NET for SIMOTION?
SIMATIC NET for SIMOTION provides:
• Access via OPC Data Access, enabling the user to read and write a SIMOTION device (e.g. control and multi–axis module SIMOTION C230–2)
• to monitor a process being executed in a SIMOTION system via OPC alarm and events.
1.1 Basic representation of design time

![Diagram showing the basic representation of design time.](image)

**Figure 1-1 Overview design time (Example)**
1.2 Basic representation of runtime

![Diagram of runtime representation]

Figure 1-2 Overview runtime (Example)
2.1 Hardware and Software requirements for design time

Hardware requirements for design time

Table 2-1 Hardware requirements for design time

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Minimum requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel Pentium II or compatible, 333 MHz</td>
</tr>
<tr>
<td>User memory</td>
<td>128 MByte RAM</td>
</tr>
<tr>
<td>Resolution</td>
<td>800 x 600 Pixel</td>
</tr>
</tbody>
</table>

Software requirements for design time

Note

Install the software following this order!

1. Windows NT® 4.0, service pack 6a and higher, or Windows 2000 service p. 1
2. STEP 7 Version 5.1 service pack 2 and higher
3. SIMATIC NET PC Software Version 6.0 (CD 07/2001) and higher
   A licence for design time will not be required for the OPC server.
   and when using “OPC Alarms and Events” also service pack 2
   Product name: “SIMATIC NET SOFTNET-S7 (S7-OPC-Server)”
4. SIMOTION SCOUT Version 2.0 and higher
2.2 Hardware and Software requirements for runtime

Hardware requirements for runtime

Table 2-2  Hardware requirements for runtime

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Minimum requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel Pentium II, 266 MHz</td>
</tr>
<tr>
<td>User memory</td>
<td>128 MByte of RAM</td>
</tr>
<tr>
<td>Monitor</td>
<td>VGA monitor, keyboard and mouse supported by Microsoft Windows NT</td>
</tr>
<tr>
<td>Memory</td>
<td>Approx. 25 Mbytes of space on your hard disk</td>
</tr>
<tr>
<td></td>
<td>At least 1 Mbyte of space on drive C: for the Setup program (the setup files are deleted again after successful installation)</td>
</tr>
<tr>
<td>Network cards</td>
<td>Profibus card, e.g. CP5611 and/or Ethernet card</td>
</tr>
</tbody>
</table>

SIMOTION device

SIMOTION C230–2 with micro memory card (restricted operation is possible even without card) resp. SIMOTION P350

Software requirements for runtime

- Client/server
  - Windows NT® 4.0 service pack 6a, or Windows 2000 servise pack 1
  - SIMATIC NET PC Software Version 6.0 (CD 07/2001) and higher
    and when using "OPC Alarms and Events" version 6.0.2 (CD 07/2001 with service pack 2)
    Product name: "SIMATIC NET SOFTNET-S7 (S7-OPC-Server)"
  - SIMOTION C230-2
    - SIMOTION Kernel (Kernel, will be supplied)
  - SIMOTION P350
    - SIMOTION Kernel


3

Communication and Handling

3.1 Basic procedure

For communication between the OPC server for SIMATIC NET with ares SIMOTION device you will have to make some preparations:

Basic tasks:

Table 3-1 Basic procedure

<table>
<thead>
<tr>
<th>When?</th>
<th>Step</th>
<th>Procedure</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design time/ run time</td>
<td>1</td>
<td>Installing the SIMATIC NET PC–Software and the communication processor</td>
<td>See section 3.3</td>
</tr>
<tr>
<td>Design time</td>
<td>2</td>
<td>Creating a project with SIMOTION SCOUT for SIMOTION device</td>
<td>See &quot;Operator’s Guide&quot; for SIMOTION SCOUT</td>
</tr>
<tr>
<td>Design time</td>
<td>3</td>
<td>Exporting OPC data in offline mode</td>
<td>See section 3.2</td>
</tr>
<tr>
<td>Design time</td>
<td>4</td>
<td>Developing a client application on the basis of OLE/COM-DCOM</td>
<td>For example in Visual Basic</td>
</tr>
<tr>
<td>Runtime</td>
<td>5</td>
<td>Loading the project to SIMOTION device</td>
<td>See &quot;Operator’s Guide&quot; for SIMOTION SCOUT</td>
</tr>
</tbody>
</table>
3.2 Exporting OPC data at the design time

In order to inform SIMATIC NET about all data configured in SIMOTION SCOUT, you have to export all usable data into a file using the menu Options -> Export OPC data... (i.e., at the design time) and then transfer the created files "OPC_DATA.ssd" and "OPC_AE.xml" to the OP.

You have the possibility to export the following data:

- "OPC Data" comprising
  - System variables of the unit and technological objects
  - Global system user variables
  - Symbolic input/output variables
  - Interface variables of user programs
    (for data types, see chapter 4.1)
- "OPC Alarm/Event", including
  - TO alarms
  - Diagnostic buffer alarms
  - Alarm_S/Q

Note
The online help in SIMOTION SCOUT describes in detail the operating sequences required in order to export OPC data.

You have the possibility to set the target directory for the symbol file.

This is the default path set by the system: "<LW>:\Siemens\Step7\S7proj\<Project_name>\U7\Tagfiles\"

3.2.1 Parameterizing the data export

If several interfaces are selected, the data export requires the following parameters:

- the device
  It displays the device for which you have to select the interface to PROFIBUS DP. You have to define the interface setting for every device in the project. Depending on the number of devices you will have to repeat the settings in this window.

- the protocol
  - PROFIBUS
  - TCP/IP (C230-2)

- the interface

Note
The selection "Interface" appears, when several interfaces are available in the SIMOTION device and were configured with different bus addresses.
Under “Interface” you can select the interface for the symbol names you want to export.

Each symbol name must be clearly assignable to a hardware address (bus address).

You can define this assignment by selecting the “interface”.

- Select X8, if you use interface X8 on the device.
- Select X9, if you use interface X9 on the device.

**Danger**

If the interface has been parameterized for equidistant bus cycle, this interface must not be used for OPs that have not been enabled for equidistant bus.

### 3.2.2 Exporting OPC data (symbol file)

The export of “OPC Data” may take some time. However, you have the possibility to shorten the data export procedure by selecting “Flat hierarchy” (i.e. w/o tree structure) resp. “Arrays with individual elements” (if this is not selected, only the first address of the array will be exported).

**Note**

If a client has been programmed for SIMATIC NET which uses symbol files that have been generated with SIMOTION SCOUT Version 1.0 or 1.1, the field “Flat hierarchy” must be selected when exporting “OPC Data” with SIMOTION SCOUT Version 2.0. If this is not the case, you have to adapt the variable names of the Client.

By default, a symbol file is stored under the name “OPC_DATA.ssd” in the target directory selected when exporting “OPC Data”.

The export process will be recorded under SIMOTION SCOUT in Detail View of tab sheet *Symbol file Export status View.*

**Note**

OPC data export will only be possible, if
- the SIMATIC NET software for PC is installed,
- a project is open and
- SIMOTION SCOUT runs in OFFLINE mode.
3.2.3 Exporting "OPC Alarm/Event"

By default, a file is stored under the name "OPC_AE.xml" in the target directory selected when exporting "OPC Alarm/Event".

The export process will be recorded under SIMOTION SCOUT in Detail View of tab sheet Symbol file Export status View.

3.3 Configuring the OPC server/SIMOTION device interface at runtime

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mount the PROFIBUS or Ethernet communication module (e.g. CP5611) to the PC. Install the SIMATIC NET PC software version 6.0 and also service pack 2 when using &quot;OPC Alarms and Events&quot;.</td>
</tr>
</tbody>
</table>
| 2    | The start-up assistant now starts automatically. You can also call the start-up assistant via menu Start–>SIMATIC–>SIMATIC NET–>Settings–>Start–up assistant. Set the properties in the pages described in the following according to the indications. Skip the pages which are not described by pressing Next.  
1. Click on the field "Use module for PG operation only" on page "Settings for PROFIBUS module". 
Note: this dialog only appears once.  
2. On the page "Symbolic", select the field "Use symbol file".  
3. If you want to use "Data" and "Alarms and Events" resp. "Data" only, please enter the file name of the symbol file, e.g. "LW:\Siemens\Step7\S7iproj\TagFiles\OPC_DATA.ssd".  
If you want to use only "Alarms and Events", select in "Set PC station" the file "LW:\Siemens\Step7\S7iproj\TagFiles\OPC_AE.XML". (You will always be suggested the previous path.)  
4. Select the SIMOTION module (e.g. "CP5611 (PROFIBUS)" on page "Extended symbols". 
Note: For installation on SIMOTION P350 do not execute this step! Please follow the instructions on the next page.  
5. By selecting Finish you finish the installation setup for the SIMATIC NET OPC Server. |
| 3    | Testing the communication processor. You can test the correct function of the module in the window "Set the SIMATIC NET PC station" (can also be called via menu Start–>SIMATIC–>SIMATIC NET–>Settings–>). In order to do so, select the module (e.g. "CP5611") and then click the button Update under "Node". |
Note
The symbol file button can only be activated when a symbol file is existing.
If any changes of project data are made using SIMOTION SCOUT after tag file export, a new exporting procedure must be executed (for consistency).

Note
For installation on SIMOTION P350, configure the interface (as described in table 3-2), then go to "PG/PC interface settings" and connect access point CP_SM_1: with SINUMERIK MCI BOARD (MPI)!
When configuring the interface, you must not execute step 4. in step 2!
You can set the access point in the menu Start→SIMATIC→SIMATIC NET→Settings→PG→PC interface.
4 System Features

4.1 System variables

For more detailed information on the exported files, you can start an XML export using SIMOTION SCOUT via menu Project→Save and export.

You can afterwards view this XML file by means of an XML–capable web browser (e.g. Internet Explorer 5 or Netscape 6.1).

This file includes information about variables such as limit values, file types and the defined values for enum–types.

Note

In order to use enums within an OPC client, a description file (idl file) will be generated in addition to the symbol file during OPC data export via menu Tools→Export OPC data....

You find a description of the limit values of the system variables for SIMOTION in the list of references “SIMOTION Technological Package CAM System Variables”.

The following data types are available for SIMOTION:

Table 4-1 Data types

<table>
<thead>
<tr>
<th>SIMOTION</th>
<th>Bit size</th>
<th>Sign</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>1 Bit</td>
<td>–</td>
</tr>
<tr>
<td>BYTE/USINT</td>
<td>8 Bit</td>
<td>–</td>
</tr>
<tr>
<td>SINT</td>
<td>8 Bit</td>
<td>yes</td>
</tr>
<tr>
<td>WORD/UINT</td>
<td>16 Bit</td>
<td>–</td>
</tr>
<tr>
<td>INT</td>
<td>16 Bit</td>
<td>yes</td>
</tr>
<tr>
<td>DWORD/UDINT</td>
<td>32 Bit</td>
<td>–</td>
</tr>
<tr>
<td>DINT</td>
<td>32 Bit</td>
<td>yes</td>
</tr>
<tr>
<td>REAL</td>
<td>32 Bit</td>
<td>yes</td>
</tr>
<tr>
<td>LREAL</td>
<td>64 Bit</td>
<td>yes</td>
</tr>
<tr>
<td>DATE</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>TD (Time of Day)</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>DT (Date and Time)</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>
### Consistent data access

Access to individual data of a simple data type of the SIMOTION device is always consistent.

But if you want to access several individual data or arrays of the SIMOTION device (e.g. positions of several axes), you will require user support in order to assure consistency.

The Programming Guide SIMOTION ST describes with a programming example how the client application (e.g. HMI device) guarantees consistent data access with the SIMOTION device by means of mutual verifying.

---

**Table 4-1  Data types, Fortsetzung**

<table>
<thead>
<tr>
<th>SIMOTION</th>
<th>Bit size</th>
<th>Sign</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>Array</td>
<td>Note: For &quot;Array&quot; the above listed data types are valid only.</td>
<td></td>
</tr>
</tbody>
</table>
4.3 Compatibility with version 2.2

When using the S7 OPC Server service pack 2 for SIMATIC NET version 2.2, you will have to note the following in order to guarantee compatibility with software SIMATIC NET version 6.0:

Upward compatibility

Table 4-2 Upward compatibility

<table>
<thead>
<tr>
<th>PC with design time</th>
<th>PC with runtime</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 OPC server service pack 2 for SIMATIC NET version 2.2</td>
<td>SIMATIC NET version 6.0</td>
</tr>
<tr>
<td><strong>Note:</strong> Here, the exported access is <strong>CP_L2_1:</strong></td>
<td><strong>Note:</strong> Access <strong>CP_L2_1:</strong> must be set here.</td>
</tr>
<tr>
<td>The access can be set via menu</td>
<td>The access can be set via menu</td>
</tr>
<tr>
<td>Start-&gt;SIMATIC-&gt;SIMATIC NET-&gt;Settings-&gt; Set the PC station</td>
<td>Start-&gt;SIMATIC-&gt;SIMATIC NET-&gt;Settings-&gt; Set the PC station</td>
</tr>
</tbody>
</table>

We recommend you to use the new software SIMATIC NET version 6.0 on both devices.

OPC Alarm and Events

OPC Alarm and Events functions are available as from Version 6.0 service pack 2.
# Notes on Online Help and Documentation

Table 5-1  Online help and documentation

<table>
<thead>
<tr>
<th>What?</th>
<th>Names</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online help SIMOTION SCOUT</td>
<td>Is part of the SIMOTION SCOUT software</td>
<td>Provides help for the user interface</td>
</tr>
<tr>
<td>Entire documentation on installation CD of the SIMOTION software</td>
<td>SIMOTION System Overview</td>
<td>Overview of the product family</td>
</tr>
<tr>
<td></td>
<td>SIMOTION Getting Started, Short Operator’s Guide</td>
<td>For a fast access to the engineering system SIMOTION SCOUT</td>
</tr>
<tr>
<td></td>
<td>SIMOTION SCOUT, Operator’s Guide</td>
<td>Describes the engineering system SIMOTION SCOUT, its installation and workbench</td>
</tr>
<tr>
<td></td>
<td>SIMOTION MCC, Programming Guide</td>
<td>Describes the graphical SIMOTION programming language Motion Control Chart</td>
</tr>
<tr>
<td></td>
<td>SIMOTION ST, Programming Guide</td>
<td>Describes the text-based SIMOTION programming language Structure Text</td>
</tr>
<tr>
<td></td>
<td>SIMOTION C230–2, Product Manual</td>
<td>Describes the hardware and start-up</td>
</tr>
<tr>
<td></td>
<td>SIMOTION Technological Functions of Motion Control, (divided up in several manuals and lists of references)</td>
<td>Describes the effects of the technological objects for Motion Control and provides the reference lists of system variables and functions</td>
</tr>
<tr>
<td></td>
<td>SIMOTION Function Blocks</td>
<td>Extension for CP and FM modules</td>
</tr>
<tr>
<td></td>
<td>SIMOTION P350, Manual</td>
<td>Describes hardware, software and installation</td>
</tr>
<tr>
<td>Entire documentation on installation CD of the SIMATIC NET software</td>
<td>SIMATIC NET PC/Windows 07/2001, electronic documentation</td>
<td>Describes the installation, the OPC interface and OPC server</td>
</tr>
</tbody>
</table>

**Note**

See the References of the SIMOTION manuals for a detailed list of the documentation on SIMOTION.
## SIMATIC NET – Support and Training

### Automation and Drives, Service & Support

Der Service & Support von A&D ist weltweit jederzeit erreichbar.

The languages of the SIMATIC Hotlines are generally German and English, in addition, French, Italian and Spanish are spoken on the authorization hotline.

### Technical Support

**Europe and Africa** (Nuremberg)

<table>
<thead>
<tr>
<th>Days</th>
<th>Time</th>
<th>Phone</th>
<th>Fax</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon.– Fri.</td>
<td>7:00 to 17:00</td>
<td>+49 – (0) 180 – 5050 – 222</td>
<td>+49 – (0) 180 – 5050 – 223</td>
<td><a href="mailto:techsupport@ad.siemens.de">techsupport@ad.siemens.de</a></td>
</tr>
</tbody>
</table>

**Authorization–Hotline**

**Europe and Africa** (Nuremberg)

<table>
<thead>
<tr>
<th>Days</th>
<th>Time</th>
<th>Phone</th>
<th>Fax</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon.– Fri.</td>
<td>7:00 to 17:00</td>
<td>+49 – (0) 911 – 895 – 7200</td>
<td>+49 – (0) 911 – 895 – 7201</td>
<td><a href="mailto:authorization@nbgm.siemens.de">authorization@nbgm.siemens.de</a></td>
</tr>
</tbody>
</table>

**America** (Johnson City)

<table>
<thead>
<tr>
<th>Days</th>
<th>Time</th>
<th>Phone</th>
<th>Fax</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon.– Fri.</td>
<td>8:00 to 19:00</td>
<td>+1 – (0) 423 – 262 – 2522</td>
<td>+1 – (0) 423 – 262 – 2231</td>
<td><a href="mailto:simatic.hotline@sea.siemens.com">simatic.hotline@sea.siemens.com</a></td>
</tr>
</tbody>
</table>

**Asia and Australia** (Singapur)

<table>
<thead>
<tr>
<th>Days</th>
<th>Time</th>
<th>Phone</th>
<th>Fax</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon.– Fri.</td>
<td>8:30 to 17:30</td>
<td>+65 – (0) 740 – 7000</td>
<td>+65 – (0) 740 – 7001</td>
<td><a href="mailto:simatic.hotline@sae.siemens.com.sg">simatic.hotline@sae.siemens.com.sg</a></td>
</tr>
</tbody>
</table>

### SIMATIC Premium–Hotline

**Worldwide** (Nuremberg)

<table>
<thead>
<tr>
<th>Days</th>
<th>Time</th>
<th>Phone</th>
<th>Fax</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>on weekdays</td>
<td>0:00 to 24:00</td>
<td>+49 – (0) 911 – 895 – 7777</td>
<td>+49 – (0) 911 – 895 – 7001</td>
<td><a href="mailto:techsupport@ad.siemens.de">techsupport@ad.siemens.de</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Days</th>
<th>Time</th>
<th>Phone</th>
<th>Fax</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>quick call–back</td>
<td>guaranteed within max. 2 hours</td>
<td>(fee based, only with SIMATIC Card)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Training Center

To help you become familiar with SIMATIC S7 programmable controllers, we offer training courses. Please contact your regional training center or the central training center in D 90327 Nuremberg.

Phone: +49 (0) 911–895–3154
Infoline: Tel. +49 (0) 1805 23 56 11
Fax. +49 (0) 1805 23 56 12
Internet: http://www.sitrain.com
E–Mail: AD–Training@nbgm.siemens.de

For information on high–availability SIMATIC S7 automation systems, the H/F Competence Center in Nuremberg offers a special workshop. The H/F Competence Center will also support you during configuring, start–up and in case of any problems occurring at site.

Phone: +49 – (0) 911 – 895 – 4759
Fax: +49 – (0) 911 – 895 – 5193
E–Mail: hf–cc@nbgm.siemens.de
CoC–SI@nbgm.siemens.de

Technical Support Online Services

SIMATIC Customer Support provides you with a wide range of additional information on SIMATIC products in the online services:

- You can obtain general up–to–date information as follows:
  - on the Internet: address http://www.siemens.de/simatic-net
  - at fax polling no. +49 (0) 8765-93 02 77 95 00
- For current product information, FAQs, tips and hints and downloads which may be helpful for your application, see:
  - On the Internet: address http://www.siemens.de/automation/service&support
  - From the bulletin board system (BBS) in Nuremberg (SIMATIC Customer Support Mailbox) at the number +49 (0) 911 895-7100.

To dial the mailbox, use a modem with up to V.34 (28.8 Kbaud), with the following parameters: 8, N, 1, ANSI, or dial on ISDN (x.75, 64 Kbits).
Further Support

If you have further questions about SIMATIC NET products, contact your local Siemens representative.

You will find the addresses:

- in our catalog IK PI
- on the Internet http://www.siemens.de/automation/partner
- in our interactive catalog CA01
  http://www.siemens.de/automation/ca01
- on our quick-start CD